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Introduction

Software development is an increasingly complex and dynamic activity.
Development frequently occurs in teams that perform parallel development on
the same application, often in geographically distributed locations. Multiple
versions of applications need to be supported, and they often must run on

different machines and operating systems.

Increased economic pressures, auditory and regulatory compliance mandates
and development process and technology complexity further intensify today’s
software development challenges. As a result, many problems can occur during

software development, including:

* Bugs that have been corrected reappear
* Previous releases of software are impossible to find or cannot be rebuilt
* Files mysteriously change or disappear altogether
Work: from one developer is replaced (lost) by work from another developer
* Builds that previously worked suddenly break
* Development team workload cannot be easily tracked
* Project status cannot be easily monitored and assessed
* It is difficult to determine what bugs have been fixed in a release and what code

changes were made to fix those bugs

How can these problems be reduced—or even eliminated? The answer is
software configuration management, or SCM. In this paper, you will discover
the key reasons why software configuration management is critical for business
success. The paper discusses how IBM® Rational® ClearCase® and IBM
Rational ClearQuest® change management solutions provide advanced SCM
capabilities that can increase productivity, improve software quality and deliver
maximum business value. It explains how Rational ClearCase and Rational
ClearQuest are integrated with Rational Developer products, including IBM
Rational Application Developer for WebSphere Software and IBM Rational
Web Developer for WebSphere Software, as well as with the open source Eclipse
framework for seamless access to SCM capabilities from within your integrated
development environment (IDE). This paper also presents best practices for
using Rational ClearCase and Rational ClearQuest from within Rational

Developer products and Eclipse to enable more efficient development.
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“The integration of Rational ClearCase
and Rational Application Developer for
WebSphere Software allows for better
productivity. From the learning curve
perspective, it seems like one
application. You don’t have to learn
two full-blown applications. By having
everything in one application,
developers can get up to speed very
quickly. This allows our developers to
get back to what they do best, which is
developing code—not learning the
application software.”

—The Revere Group

Why software configuration management?

Software configuration management (SCM) helps to establish and maintain the
integrity of software products throughout the development life cycle. Through
capabilities such as version control, build management, defect and change

tracking, release management and process control, SCM can help deliver:

* Increased productivity through parallel development and automated processes

* Better operational efficiency through improved team communication and
collaboration, support for large distributed teams, enhanced reliability and minimized
downtime

* Reduced cost through the leveraging of existing investments and increased software reuse

* Faster time-to-market through streamlined development and reduced release/build
cycle times

* Enhanced software quality by preventing users from making mistakes and reducing
bugs in delivered code

* Increased ability to meet compliance requirements with a well-defined, repeatable,

auditable process

By protecting and managing business-critical software assets and by
automating and enforcing the development process, SCM tools can help enable
development teams to produce higher-quality software faster and with lower
cost and risk. The key is to implement SCM tools that can easily integrate with

existing systems and development environments.

Improve productivity and gain long-term value with industry-leading SCM solutions
IBM Rational change management products, including IBM Rational
ClearCase and IBM Rational ClearQuest, lead the SCM tools market.! Part of
the IBM Rational Team Unifying Platform™, a set of integrated tools that span
the full application development life cycle, IBM Rational change management
products deliver proven technology to help developers and project managers

effectively manage change and assets.

! Melissa Webster. “Worldwide Software Configuration Management Tools Competitive 2003
Vendor Shares.” IDC #31689. August 2004.
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Going well beyond software revision control and versioning capabilities,
Rational ClearCase and Rational ClearQuest deliver advanced SCM capabilities
that provide development team members with instant, controlled access to the
information they need to create, update, build, deliver, reuse and maintain

business-critical software assets that can be developed faster and at lower cost.

Rational ClearCase: So much more than version control

Rational ClearCase products provide an extensive range of software asset
management capabilities. From IBM Rational ClearCase LT to IBM Rational
ClearCase to IBM Rational ClearCase MultiSite® change management
solutions, organizations can choose the Rational ClearCase product that best

meets their development needs.

Rational ClearCase LT provides version control for small to midsize collocated

teams. Easy to install and manage, Rational ClearCase LT offers:

* Version control for files, directories or other assets produced during the development
life cycle, with annotated histories of source code, binaries, executables,
documentation, test suites, libraries and Web elements.

* Automated workspace configuration with snapshot views. These views give easy
access to the correct versions of files and directories required to complete a specific
task while shielding team members from potentially destabilizing changes being
made by other developers. This is done by loading the required versions of files and
directories onto the developer’s desktop—a feature ideally suited to disconnected users
and early-stage projects that require isolation

* Parallel development support, including automatic branching to enable multiple
development teams to work independently from the same code base, and proven
diff/merge technology that automatically accepts uncontested changes and highlights
conflicting changes for fast resolution.

* Remote client interface enables remote developers to access versioned objects in a
centralized repository via a wide-area network (WAN) or a virtual private network
(VPN) connection. The remote client interface uses automatic update technology
(based on the Eclipse Update Manager technology) to allow users and administrators
to manage the updates of many clients by simply pointing at the server’s URL and
auto-updating the client with new versions.

 Web interface offers easy access from standard Web browsers virtually anytime,

anywhere.
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“It is not good if your project has 200
developers and it takes on the order of
36 hours to complete the compile
process each time someone wants to
rebuild the product. With Rational
ClearCase, we were able to reduce that
time to about 30 minutes.”

—Peace Software

Tight integration with Rational ClearQuest provides smooth access to workflow
management and change and defect tracking.

Wide operating system support includes support for Linux®, Microsoft® Windows®
and UNIX® operating systems.

Easy installation is the result of intuitive startup wizards to automate server setup and
built-in TCP/IP networking for simplified administration in heterogeneous environments.
Deep integration with leading IDEs including Rational Developer products, IBM
WebSphere® Studio, Microsoft Visual Studio® .NET and the open source Eclipse
framework.

File conversion from other version control and SCM products, including CVS, to
speed migration activities.

Seamless upgrade to Rational ClearCase enables organizations to grow and meet

evolving business needs without retraining, retooling or migrating data.

Rational ClearCase provides complete software asset management for midsize to

large development teams. It extends the value of Rational ClearCase LT by adding:

Flexible workspace management using dynamic or snapshot views. Dynamic

views, provide global, transparent access to virtually any version of any element—a
Seature ideal for an audited build environment or a complex project that requires
instantaneous updates to evolving source files

Advanced build management to automatically produce a detailed bill of materials,
re-create any previous build at any time, and provide build avoidance capabilities so
developers do not spend time building files that have already been built by another
developer

Support for multiple repository server deployments for large-scale enterprise teams
Mainframe development support, including IBM 0S/390® and IBM eServer zSeries®
platforms running SUSE LINUX operating systems

Seamless addition of Rational ClearCase MultiSite that enables parallel development

across geographically distributed environments

Rational ClearCase MultiSite is an optional addition to Rational ClearCase that

enables parallel development across geographically distributed environments,

offering:

* Distributed development support enabling distributed teams on multiple distributed

servers to create complex applications in parallel through automatic replication



Improve developer productivity with

IBM Rational ClearCase and IBM Rational ClearQuest

Page 6

* Simplified administration of all replicas from the local site via a Web-based
administration console

* Automatic backup and restore to maintain business continuity in case of disaster

* Data integrity by automatically resending information in the event of network failure
and recovering repositories in the event of system failure

* Improved performance by transmitting only incremental changes that appear in

Rational ClearCase project repositories

Rational ClearQuest: Flexible defect and change tracking and workflow management
Rational ClearQuest captures and manages all types of change requests
throughout the development life cycle, including defects, enhancements, issues
and documentation changes. Out-of-the-box, predefined workflows enable
development teams to get up and running quickly. Workflows, as well as the
user interface, defect and change request fields, queries and charts can also be

easily customized using simple point-and-click features.

To ensure that the entire development team is tied into the change management

process, Rational ClearQuest offers:

* Robust, flexible workflow support including e-mail notification options

* Activity-based defect and change tracking

* Easy customization using simple point-and-click features

* Comprehensive support for queries with extensive charting and reporting

* Tight integration with Rational ClearCase for smooth access to software asset
management

* Web interface for easy access from standard Web browsers virtually anytime, anywhere

* Wide platform support including Linux, Microsoft Windows and UNIX systems

s Deep integration with leading IDEs, including Rational Developer products, WebSphere
Studio, Microsoft Visual Studio .NET, and the open source Eclipse framework

* Scaling to support projects of virtually any size

For distributed development environments, IBM Rational ClearQuest MultiSite
extends the value of Rational ClearQuest by offering:

* Distributed workflow support enabling geographically disparate teams on multiple
distributed servers to manage and track activities through automatic replication of

schema repositories
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“The best thing about Rational
ClearQuest is that it is totally
customizable. As our organization
changes, Rational ClearQuest can
change with it.”

—ProCard Inc

* Data integrity by automatically resending information in the event of network failure
and recovering repositories in the event of a system failure
* Improved performance by transmitting only incremental changes that appear in

Rational ClearQuest repositories

Simplifying development through activity-based change management

Activity-based change management allows you to manage and track individual
changes to software assets throughout the application life cycle as higher-
level activities rather than as changes to individual files and directories.
Managing activities instead of their related assets within the context of the
overall development process provides greater clarity and insight. It streamlines
and simplifies the development process, enabling development teams to work

together more efficiently and effectively.

Rational ClearCase and Rational ClearQuest enable activity-based change
management through Unified Change Management (UCM), the set of features
within these products that enables you to define and manage changes to
software assets as activities. With UCM you can associate specific versions of
files and directories with activities. Operations, such as delivering code to the
integration stream, are then performed on the activity instead of on individual
files. This level of abstraction reduces the build and integration errors caused
by developers forgetting which files they modified when delivering their
changes. It also helps ensure that testing is performed against the versions

of files being integrated. The status of activities in Rational ClearQuest is
automatically updated when developers work on them in Rational ClearCase,

helping keep the project status up to date.

By enabling this activity-centric approach, project members (including
project leaders, developers, testers and customer support) can communicate
more effectively. Developers can get up and running quickly on new projects.
Teams can effectively baseline requirements together with code, models, test
assets and more. Project managers can easily manage and track the status

of proposed changes and better understand the impact of proposed changes

across the project.
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Through UCM, Rational ClearCase and Rational ClearQuest also provide
customizable, automated workflows that consistently enforce the development
process. From submitting change requests to assigning those requests to
resolving and verifying changes, you have full control over how each change is

managed and implemented.

By managing change through high-level activities and by managing the change
process through workflows, Rational ClearCase and Rational ClearQuest can

enable you to:

* Streamline code reviews and testing efforts
* Reduce build and integration problems

* Automate the development process

* [Facilitate reporting

* Simplify project management

Start with an effective IDE

To meet your business objectives, it is critical to enable diverse development
teams across your enterprise to deliver high-quality applications quickly.
Developers need a development environment that supports the entire
development life cycle—from development to integration and testing to ongoing

maintenance.

Eclipse: Flexible open source technology

Eclipse is an open, extensible industry-supported platform designed for
building diverse applications such as Web sites, embedded Java™ programs
and C++ programs. Fast becoming a popular framework for cross-platform

development, Eclipse offers many benefits to developers, including:

* Cross-platform support for Linux, Windows, Solaris, IBM AIX 5L® and HP-UX
operating environments

* A familiar and intuitive graphical project workspace

* Smooth integration of tools and features through plug-ins

* Support for both graphical user interface (GUI)- and non-GUI-based application
development

* Availability at no charge to developers under an open source license
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By providing a common interface, an optimized process that closely parallels
how developers work and the ability to support collaborative development with
a common user model, the Eclipse platform is designed to enable increased

productivity while leveraging existing and newly acquired tools.

Rational Developer products: Extending the value of Eclipse

Rational Developer products provide a flexible, portal-like integration of
multi-language, multi-platform and multi-device application development
tools. They are designed to enable developers to rapidly build, test and deploy
dynamic applications. Visual tools, templates and wizards help developers
quickly and easily perform many development tasks—from building dynamic
Web sites and Web applications to developing advanced enterprise applications

that span disparate platforms.

Rational Developer products can provide a single development environment
that can scale to support multiple types of development, including Web,
business logic, integration and traditional development. As a result, all the
developers on a team use the same environment—customized to meet their
individual development needs—and can easily collaborate as they develop

applications.
Rational Developer products include:

* IBM Rational Web Developer for WebSphere Software, an easy-to-use, highly
productive development environment with visual rapid application development (RAD)
tools for building and maintaining dynamic Web, Web services and Java applications

* IBM Rational Application Developer for WebSphere Software, a comprehensive
development environment with high-productivity tools for building and maintaining

Web, Web services, Java, Java 2 Enterprise Edition (J2EE™) and portal applications
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“Having Rational ClearCase and
Rational ClearQuest integrated with
Eclipse enables our developers to
work faster, simply because they are
not switching between multiple
interfaces. Additionally, they get better
performance by not having as many
tools open on their desktop.”
—BearingPoint, Inc.

Rational Developer products are built on Eclipse technology. They are designed
to enable developers to maximize productivity by integrating best-of-breed
plug-in tools from IBM, IBM Business Partners and the Eclipse community to
customize their development environment to match their roles and needs. This
integration enables developers to focus on delivering a solution that satisfies

their requirements instead of switching between various development tools.

Integrated SCM is the key

Ifthe goal is to develop higher quality applications faster and at lower cost, then
the speed and ease with which development tasks can be performed is a major
consideration. As discussed, effective SCM tools can improve productivity and
reduce cost. However, performing change management operations from within
their IDE allows developers to “stay in one place” and access SCM functions in
the same familiar way they access other IDE functions, dramatically improving

productivity.

World-class SCM integrated with Rational Developer products and Eclipse
Rational ClearCase and Rational ClearQuest are integrated with a variety of
IDEs, including Rational Web Developer for WebSphere Software, Rational
Application Developer for WebSphere Software and Eclipse. From within
these Rational Developer products and Eclipse, developers can directly access
Rational ClearCase and Rational ClearQuest functions. Rational Application
Developer for WebSphere Software also makes it easier for teams to get started

with SCM by including the Rational ClearCase LT software.

Rational ClearCase and Rational ClearQuest functions are exposed through
product perspectives, views, menus, toolbars and context-sensitive pop-up
menus. This allows Rational and Eclipse developers to interact with Rational
ClearCase and Rational ClearQuest in the same way they interact with their
IDEs. It also enables Rational and Eclipse developers to efficiently support
collaborative development with a common user model. Additionally, the
Rational ClearCase and Rational ClearQuest integrations provide several
operations to help streamline and automate common tasks, further improving

developer productivity.
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Figure 1: IBM Rational ClearCase access from IBM
Rational Application Developer for WebSphere

Software

Although Rational ClearCase and Rational ClearQuest functions are accessed the
same way from both Rational Developer products and Eclipse, the remainder of this

discussion is specific to Rational Application Developer for WebSphere Software.

Accessing IBM Rational ClearCase

To access IBM Rational ClearCase functions from within Rational Application
Developer for WebSphere Software, the Rational ClearCase or Rational
ClearCase LT client software must be installed. Once Rational ClearCase has
been installed, Rational Application Developer must then connect to Rational
ClearCase in order to enable Rational ClearCase operations within the IDE.
You can do this by selecting the Connect to Rational ClearCase icon in the

Rational Application Developer toolbar, as shown in Figure 1.
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After Rational Application Developer is connected to Rational ClearCase,
Rational ClearCase functions can be accessed in several ways: through the
Rational ClearCase pull-down menu; by selecting a file, right-clicking and
selecting the Team option from the context menu; or by clicking on icons on the

Rational ClearCase toolbar.



Improve developer productivity with

IBM Rational ClearCase and IBM Rational ClearQuest

Page 12

Figure 2: IBM Rational ClearCase access from the

Team Context menu

The Rational ClearCase pull-down menu, shown in Figure 1, enables

Rational Application Developer for WebSphere Software users to perform
specific Rational ClearCase operations from within the Rational Application
Developer workspace. If using Rational ClearCase LT, items only supported in
Rational ClearCase but not in Rational ClearCase LT will be disabled. Rational
Application Developer for WebSphere Software users must upgrade to Rational

ClearCase to access these functions.

The Rational ClearCase toolbar, also shown in Figure 1, is used to perform
frequently used Rational ClearCase functions. Developers can quickly and
easily perform Rational ClearCase and UCM functions through a simple mouse

click from within the Rational Application Developer workspace.
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The Rational ClearCase Team option on the context menu, shown in Figure 2,
provides another method of accessing Rational ClearCase functions directly
from Rational Application Developer for WebSphere Software. Note that many
functions, such as source control operations, are available on common project
files through the Rational ClearCase pull-down menu, Rational ClearCase

toolbar and Team option on the context menu.
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Table 1: IBM Rational ClearCase functions in IBM
Rational Application Developer for WebSphere

Software

The following table provides an overview of Rational ClearCase functions

that can be performed from within the Rational Application Developer for

WebSphere Software user interface. Specific information on each function

is available via IBM Rational ClearCase online help within the Rational

Application Developer user interface.

IBM Rational
ClearCase menu
options

Team Context menu
options

IBM Rational
ClearCase
toolbar icons

Connect to Rational ClearCase
Set Current Activity

Deliver Stream

Rebase Stream

Update View

ClearCase Build*

Run ClearCase Explorer
Find Checkouts

Find Resources to Add To Source
Control

Run Merge Manager
Create New View

Join UCM Project

Edit View Properties
Start/Stop View*
Mount/Unmount VOB*
ClearCase Help

Add to Source Control
Check Out

Check In

Undo Check Out
Update

Refresh Status

Hijack

Undo Hijack
Compare With Previous Version
Show Properties
Show Version Tree
Show History

Connect to Rational ClearCase
Add to Source Control

Check Out

Check In

Undo Check Out

Set Current Activity

Deliver Stream

Rebase Stream

Refresh Status

Update

Compare With Previous Version
Show Version Tree

Show Properties

Update View

ClearCase Build*

Run ClearCase Explorer
ClearCase Help

Working Remotely with IBM Rational ClearCase

Changes in today’s work environment enable more and more software

developers to work from home or other remote locations using broadband or

dial-up connections. Rational ClearCase provides software asset management

features that make it easy for development teams to work with resources

in a shared repository regardless of where team members are located. The

Rational ClearCase Remote Client feature allows developers to access Rational

ClearCase from a variety of network connections, including broadband (WAN)

and dial-up, in addition to traditional local area networks (LANs), using an

HTTP(s) connection to a Rational ClearCase Web server.

* Feature is not available in IBM Rational ClearCase LT
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The Rational ClearCase Remote Client is a lightweight, rich client interface that
can be used as a stand-alone application or completely integrated with Rational
Developer products or Eclipse. To access Rational ClearCase functionality from
within Rational Application Developer for WebSphere Software, users must first
install the IBM Rational ClearCase Remote Client into their current Rational
Application Developer installation. Once the Rational ClearCase Remote Client
has been installed, users can access Rational ClearCase capabilities from the
ClearCase perspective. Rational ClearCase capabilities can also be easily added
to any Rational Application Developer perspective by selecting Window > Show
View... > Other, and then selecting ClearCase and the view you wish to add to
the current perspective. The following views are available from the ClearCase

perspective or from any other Rational Application Developer perspective:

* ClearCase Navigator

* ClearCase Details

* ClearCase Search

* ClearCase View Configuration

* ClearCase History

* ClearCase Deliver

* ClearCase Rebase

* ClearCase Merge Search Results

Once the Rational ClearCase Remote Client has been installed, Rational
Application Developer must connect to a Rational ClearCase Web server to
enable Rational ClearCase Remote Client operations in the IDE. You can do

this by selecting the Connect to Rational ClearCase Servericon in the Rational
ClearCase perspective. Then Rational Application Developer for WebSphere
Software users can perform the following functions from the Rational ClearCase

perspective:

* Create and manage Rational ClearCase Web views. Rational ClearCase Web views
allow users to access Rational ClearCase repositories via a HTTP(s) connection to
the Rational ClearCase Web server

s Perform basic version control operations, such as check in, check out and add to
source control

+ Compare and merge files and perform advanced merge searches
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Figure 3: The ClearCase perspective in IBM Rational

Application Developer for WebSphere Software

View/edit properties of Rational ClearCase objects

View the history of Rational ClearCase elements

Perform namespace operations on Rational ClearCase elements

Perform UCM operations such as Deliver, Rebase and Finish Activity

View Cheat Sheets to quickly get started with the Rational ClearCase Remote Client

using a task-oriented approach

Additionally, the Rational ClearCase Remote Client can be integrated with
other perspectives through the Team context menu, Rational ClearCase menu
bar and Rational ClearCase toolbars. The integration has been designed to

enhance developer productivity by providing capabilities such as:

Ability to import Eclipse projects and Team Project Sets directly from the Rational
ClearCase perspective

Automatically update Rational ClearCase view load rules during the import of
Eclipse projects or Team Project Sets

Performs comparisons and merges of Java source files within the IDE

Perform long-running operations in the background

Quickly compare or replace workspace resources with other Rational ClearCase

versions through the Compare With and Replace With context menus
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Figure 4: Adding an IBM Rational ClearQuest
view to a perspective

Accessing IBM Rational ClearQuest

To access Rational ClearQuest functionality from within Rational Application
Developer or Eclipse, users must first install the IBM Rational ClearQuest
Client for Eclipse into their current Rational Application Developer or Eclipse
installation. Once the Rational ClearQuest Client for Eclipse has been
installed, users can access Rational ClearQuest capabilities by opening the
ClearQuest perspective. Rational ClearQuest capabilities also can be added
easily to any Rational Application Developer perspective by selecting Window
> Show View... > Other, and then selecting ClearQuest and the view you wish

to add to the current perspective, as shown in Figure 4.
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The following views are accessible from the Rational ClearQuest perspective or

from any other Rational Application Developer perspective:

* ClearQuest Navigator

* ClearQuest Query Results
* ClearQuest Record Details
* ClearQuest Chart

* ClearQuest Report

* ClearQuest SQL Query

The Rational ClearQuest integration also leverages the standard Eclipse views

such as the Properties and Console views.
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Figure 5: ClearQuest perspective in IBM Rational

Application Developer for WebSphere Software
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It’s just that easy. As soon as the ClearQuest Client for Eclipse has been
installed, Rational Application Developer users can perform the following

Rational ClearQuest functions from the Rational ClearQuest perspective:

* Log on to any Rational ClearQuest user database or multiple databases
simultaneously.

* Create, modify and run any public or private queries from the Rational ClearQuest
Navigator view.

* View the query results directly in the Rational ClearQuest Query Results view.

* Select and run any public or private charts from the Rational ClearQuest Navigator
view.

* View charts directly in the Rational ClearQuest Chart view.

* Select and run any public or private reports from the Rational ClearQuest Navigator

view.

* Create new reports from existing report formats.
* View report results directly in the Rational ClearQuest Report view.

* View and update detailed information for any record in the Rational ClearQuest

Record Details view.

* Submit any Rational ClearQuest record type directly from the Rational ClearQuest

Query Results view, the Rational ClearQuest Menu or Rational ClearQuest toolbar.
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* Print record details and query results from the Rational ClearQuest Record Details
and Query Results views.
* Create templates for record submission forms.

* Open attachments directly within Eclipse-based editors based on file type.
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Additionally, the Rational ClearQuest Client for Eclipse has been designed to

enhance developer productivity by providing capabilities such as:

* Ability to submit and run queries and view query results from any perspective in
Rational Application Developer or Eclipse

* Single-click submission of new Rational ClearQuest records for compiler errors or
warnings in the Problems view or Java editor, as shown in Figure 6

* Ability to submit new Rational ClearQuest records for items in the Eclipse Tasks view

or any general Eclipse resource, such as a Java class or package

The Rational ClearQuest Client for Eclipse provides users of Rational
Application Developer with all the Rational ClearQuest tools they need tightly
integrated in their IDE.
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Best practices

Having a good tool is one thing; using it effectively is another. Seven areas

of best practices are identified for using Rational ClearCase and Rational
ClearQuest with Rational Developer products or Eclipse. These best practices
have been gleaned from vast experience working with these products and can

help you enable more efficient development.

Isolate subsystems or architectural layers into separate components

A component-based architecture helps promote software reuse and sharing
among applications. In a Java or J2EE application, a good candidate for a
component is any logical grouping of files that need to be baselined and
released independently or that are shared by multiple applications. For
example, a Rational Application Developer project that produces several Java
archive (JAR) files that are shared among many applications may be a good
candidate for a component. With UCM, these components can be baselined
independently and shared among multiple UCM projects. UCM components
should not be confused with fine-grained Java artifacts, such as classes,
packages, JARs and enterprise archive files (EARs), which do not necessarily
constitute UCM components by themselves. Creating UCM components for
such fine-grained artifacts may lead to an unnecessarily large number of

components.

Perform version control for necessary files only

Source files are generally versioned and shared with other project team
members, while files that have been built in a developer’s private stream are
typically not intended to be shared with the entire team. Users must ensure
that the right files are versioned; a user may not want to version and share
compiled files (ex: .class files) and build settings, but may wish to version and
share source files. Rational Developer products provide an option for ignoring
specific file types that you do not wish to add to source control. The Rational
ClearCase integration adds a default list of file types to this list of ignored
resources. See the Rational Developer products help for more information on

ignored resources.
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Use a staging area for versioning deployed assets

Although files that have been builtin a private development stream are not
typically shared, itis a good practice to perform version control on built
artifacts that will be deployed as part of an application once a stable baseline
of that application has been produced. Thisis typically done in a staging area
VOB whose structure often reflects the structure of the deployed application.

Use a separate Rational Developer workspace for each ClearCase view

Often, developers work with multiple Rational ClearCase views to access
different versions of the same Rational Developer project, and these views must
be accessible from the Rational Developer workspace. It is recommended that
you associate one Rational ClearCase view with a unique Rational Developer
workspace. For example, if you want to work in a parallel-development
environment where you have a development view A for bug fixes to release

A and another development view B for release B of the same application,

you should use two different Rational Developer workspaces—one for view A
and one for view B. This makes it easy to switch among different versions of

the same Rational Developer project by simply opening another workspace
associated with the necessary Rational ClearCase view. It is also a good practice
to use the same name for the workspace as the Rational ClearCase view it is
associated with. To switch from one workspace to another, select File > Switch
Workspace from the main Rational Developer menu and select the desired

workspace.

Create a standardized development environment

Itis important that all project team members share a common development
environment to help ensure consistency and reduce integration problems
typically related to inconsistent build settings or other configuration problems.
One way to help avoid these problems is by sharing common configuration

information with simple projects. Simple projects can be used to store common
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project artifacts, such as getting-started instructions, build instructions and
guidelines for team preference settings. Sharing this information can save
developers time by providing consistent workspaces, build settings and other

environment settings.

Use Team Project Sets to define consistent lineups of Rational Developer projects
Team Project Sets specify a list of Rational Developer product projects that are
under version control, which can then be quickly imported all at once. Using
Team Project Sets saves time for developers because they do not have to import
individual projects. They are also free from having to understand project

dependencies and they can ensure consistency within each workspace.

Add third-party libraries to source control

To help eliminate dependencies on local build environments and
incompatibilities between JAR versions, third-party JAR libraries should be
placed under version control. Rational Developer product projects can then
reference these third-party libraries as external JARs, allowing team members
to have a common class path because the JAR files are stored in a single,

common location under version control.
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Summary

Software developers face significant challenges, including increasing software
complexity, increasing development environment complexity, mounting
time-to-market pressure and higher software quality expectations. Software

configuration management can help reduce or eliminate these challenges.

IBM Rational ClearCase and IBM Rational ClearQuest are proven SCM
solutions that manage change and complexity. Going well beyond version
control, they provide advanced capabilities that enable parallel development,
promote reuse, support large distributed teams, reduce build/release cycle

times, minimize downtime and reduce risk.

Rational ClearCase and Rational ClearQuest are seamlessly integrated with

IBM Rational Developer products and the open source Eclipse framework. This
deep integration enables a wide array of SCM operations to be performed directly
from within the Rational IDEs and Eclipse framework. By combining these
popular Java and J2EE IDEs with industry-leading SCM solutions, IBM delivers
everything that developers need to work effectively in a team environment
without requiring them to leave their IDE. The result can be dramatically

increased productivity, improved quality and maximum business value.
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For more information
Rational ClearCase and Rational ClearQuest plug-ins for Rational Application
Developer for WebSphere Software, Rational Web Developer for WebSphere

Software and Eclipse are available for download at:
ibm.com/developerworks/rational/

To learn how IBM Rational ClearCase and IBM Rational ClearQuest can help

streamline development and improve productivity, visit:

ibm.com/software/rational/offerings/scm.htmi


http://ibm.com/developerworks/rational/
http://ibm.com/developerworks/rational/
http://ibm.com/software/rational/offerings/scm.html
http://ibm.com/software/rational/offerings/scm.html
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